Troubleshooting a Cisco Business Wireless M esh
Networ k

Objective

This document will cover several areas to analyze when troubleshooting Cisco Business Wireless (CBW)
mesh networks.

If you have atraditional wireless network, you should check out Troubleshooting a Traditional Cisco
Business Wireless Network.

Applicable Devices | Firmware Version

140AC (Data Sheet) | 10.1.1.0 (Download |atest)
141ACM (Data Sheet) | 10.1.1.0 (Download | atest)
142ACM (Data Sheet) | 10.1.1.0 (Download | atest)
143ACM (Data Sheet) | 10.1.1.0 (Download | atest)
145AC (Data Sheet) | 10.1.1.0 (Download |atest)
240AC (Data Sheet) | 10.1.1.0 (Download |atest)
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I ntroduction

Mesh wireless networks are awesome, but let’ s face it, things happen! Just like any wireless network, a
number of things can cause problems. Sometimes there is a simple fix, while others might be more
complicated.

If you are unfamiliar with termsin this document, check out Cisco Business: Glossary of New Terms.

For optimum performance and reliability, keep these in mind!

1. Make sure the area has full coverage for the expected number of clients and their applications.
Additional wireless access points may need to be added in order to smooth out the performance across
your total wireless infrastructure.

2. Be aware of the types of applications they may be using (or as an administrator, the types of
applications you may allow).

3. Clients running video streaming applications consume more bandwidth than those that may be
streaming audio-only programs. Video applications rely on buffering to provide a decent experience.

4. Clients running voice-related applications require immediate service with no delays while not being as
bandwidth-intensive. Since there is no buffering with avoice call, it is very important that packets are
not dropped.

Ready for some troubleshooting? Let’ s dig in!
Beginner Help

Thistoggled section highlights tips for beginners.

Logging In

Log into the Web User Interface (Ul) of the Primary AP. To do this, open aweb browser and enter
https://ciscobusiness.cisco.com Y ou may receive a warning before proceeding. Enter your credentials.Y ou
can also access the Primary AP by entering https.//[ipaddress] (of the Primary AP) into aweb browser.

Tool Tips

If you have questions about afield in the user interface, check for atool tip that 1ooks like the following:


https://www.cisco.com/c/en/us/support/docs/smb/switches/Cisco-Business-Switching/kmgmt-2331-glossary-of-non-bias-language.html

Trouble locating the Expand Main Menu icon?

Navigate to the menu on the left-hand side of the screen, if you don’t see the menu button, click thisicon to

open the side-bar menu.

Cisco Business App

These devices have companion apps that share some management features with the web user interface. Not
all featuresin the Web user interface will be available in the App.

Download iOS App Download Android App

Frequently Asked Questions

If you still have unanswered questions, you can check our frequently asked questions document. FAQ

Are CBW access points compatible with other Cisco wireless devices?

CBW access points are not compatible with the Cisco Wireless LAN Controllers (WLCs) or other Cisco
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wireless access point series, such as Mobility Express. The CBW devices cannot coexist on the same
network as WL Cs. Additionally, the CBW Wi-Fi 5 product line (14x and 240 series) isincompatible with
the CBW Wi-Fi 6 product line (15x series). If a CBW access point is placed on the same network as any of
the incompatible products mentioned, it may enter a boot loop. In rare cases, it might even attempt to install
afirmware update from the incompatible product, leading to bootloader corruption and product failure.

When troubleshooting, why not start with the basics?

Check Physical and Environmental Conditions

Thisisthe easiest way to troubleshoot but is often overlooked. Even though these may appear to be obvious,
it isgood to start with the basics.

1. Isal the equipment turned on?

2. Isthere power to everything?

3. Do you have alink light on consistently? Green lights are a good sign!

4. Are the cables connected correctly?

5. Could it be a bad cable?

6. s any of the equipment overheated?

7. Could there be environmental factors such aswhereit islocated?

8. Are there metal or thick walls between the AP and the wireless device?

9. If the client is completely unable to connect, could the client be out of range?

Other Itemsto Consider

1. Restart the AP

2. For APs connecting to a switch, check the switch configuration and verify that the switch isrunning in
good health. The CPU utilization, temperature, and memory utilization should be below the specified
threshold levels.

3. On the Web Ul, under Monitoring, check the Wireless Dashboard to gather information on
performance and other issues.

4. Enable Bonjour and Link Layer Discovery Protocol (LLDP) on the router if it is available.

5. Enable Wireless Multicast Forwarding when available for gaming and streaming applications.

6. Make sure all Primary Capable APs are on the same VLAN.

7. If you've logged into the Primary AP viawireless, and you edit certain settings, such asthe VLAN,
you may be disconnected. Connecting to the Primary AP viawired allows that connection to remain
more stable.

Number of SSIDs

Every SSID requires sending a beacon frame every 100 milliseconds (ms), which can eat up alot of channel
utilization.

It is best to limit the total number of SSIDs on the AP to 1-2 SSIDs per radio or per AP, even though the
mesh network can support up to a physical limit of 16 SSIDs per radio.



Areyou having troublelogging into the Primary AP?

Perhaps you have tried to log into ciscobusiness.cisco, and are encountering problems. Check out these
simple suggestions:

* If you just completed Day Zero configurations, close the app and then re-launch it.

» Make sure the correct Service Set Identifier (SSID) is selected. Thisisthe name that you created for
the wireless network.

* Log into the Primary AP with https://<IP address of the Primary AP>. The Primary AP addressisthe
assigned | P address you used in the initial set up procedure. If you opted out of assigning a manual
address at that time, check your router for the DHCP |P address given to the Primary AP management
page. The management address will be assigned on MAC address 00:00:5e:00:01:01.

* Onceyou do initial setup, be sure https:// is being used whether you are logging into
ciscobusiness.cisco or by entering the |P management address into your web browser. Depending on
your settings, your browser may have auto-populated with http:// since that is what you used the very
first timeyou logged in.

» The problem might be your web browser. For example, in Firefox you would click on the menu at the
top right of the screen. Select Help > Troubleshooting I nformation and click on Refresh Firefox.

» Disconnect any Virtual Private Network (VPN) for either the mobile app or on alaptop. Y ou might
even be connected to a VPN that your mobile service provider uses that you might not even know. For
example, an Android (Pixel 3) phone with Google Fi as a service provider thereisabuilt-in VPN that
auto-connects without notification. This would need to be disabled to find the Primary AP.

* |f you have an Android phone, you may be using a private Domain Name Server (DNS) and may need
to disable this feature for connectivity. To check this, you can typically find this under Settings >
Network and Internet > Advanced > Private DNS.

Do you havethe latest version running on your APS?

Why It’s I mportant

Firmware, also referred to as software, comes embedded on your access point. Upgrading firmware
improves the performance and stability of your AP. Upgrades may include new features or fix a
vulnerability that was experienced in the previous version of the software. Isit really that important?
Absolutely! It isso vital that al the links for upgrades were added in the Firmware Version section of this
article. This could be asimple solution to try if you are having network problems. Y ou may have issues
when adding the first Mesh Extender to a network if there is afirmware version mismatch, so why not
update them all right away!

It is extremely important to update all Mesh Extenders before updating the Primary Capable APs.

Y ou can upgrade the firmware in a number of ways, but it is recommended that you use Cisco.com for the
upgrade. If you would like assistance in upgrading firmware, check out Update Software of a Cisco
Business Wireless Access Point.

Upgrade Troubleshooting


https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html

Sometimes an upgrade doesn’t go smoothly. There are some simple things you can try:

1. Refresh or close the web browser.
2. Clear the browser cache and re-log into the Primary AP. The process for this varies based on the web

browser you use.

3. Click on an alternate page or tab in the Primary AP Web User Interface (Ul) and then go back to the
Software Update page and try the firmware image download again.

4. Try anew web browser. For example, if you were using Chrome and it isn’t working, try Firefox.

5. On rare occasions, if the management page failed to start the firmware upgrade or is unresponsive (no
status change after initiating upgrade), it may be necessary to power off/on all the access points and
mesh extenders on the network and retry the firmware upgrade.

Do any of these situations apply to you?

* If you are using the downstream Ethernet port on the CBW240, switch to another port.

* If you are using captive portal, avoid using Chrome-based browsers, including Microsoft Edge.
Sometimes you may not be able to joing the network. It might be as simple as using Firefox as your
browser.

» If aclientisusing aVPN connection without split tunneling/split DNS, the CBW management page
may be inaccessible and the mobile app may not function. Try temporarily disabling the VPN on the
client to access CBW management functions.

* |f private DNS s enabled on the client, DNS queries are encrypted and CBW cannot intercept them.
Thiswill prevent the Cisco Business mobile app from working and will prevent ciscobusiness.cisco
from resolving. It is recommended that you either manage CBW from a client joined to the network
without private DNS, or manage CBW using the Web Ul viathe management I P address.

» Make sure CBW devices are not set up in the same VLAN as a Cisco Wireless LAN Controller.

Could it be a connectivity issue?

Run Connectivity Testsfrom the Web User Interface (Ul)

The AP must be able to communicate with other devicesto be effective. A simple way to check thisisto
perform a ping.

Ping the AP from at |east two clients that are connected (associated) to that particular access point.

Ping from the router to the access point |P address to see if end-to-end connectivity is available. Ping from
the router to the wireless clients associated with the AP to check if they can be reached from the main
network.

Potential DHCP Problems

Even though you probably assigned a static |P address to your Primary AP, this AP still needs to have



access to aDHCP server. This DHCP server must be operational and reachable from the LAN Ethernet port
of the AP. Thisis necessary so the Primary AP can provide IP addresses for all APs and clients that join the
network. If you see ablinking red light on the Primary after areboot, this could be your problem.

Even though a static | P address can be chosen for CBW management, it only applies to the managemetnt |P
address. Every access point, including mesh extenders need a separate | P address for its access point
functionality. The management MAC addressis 00:00:5e:00:01:01.

Evenif all CBW addresses are configured as static, adding a new AP or mesh extender still requires a
DHCP server for the initial installation of the new device, even if you plan to change it to a static IP address
later.

It's possible that there are more clients needing an | P address than are available in the DHCP pool. See the
section How to View or Change the Pool of IP Addresses for DHCP section the article Best Practices for
Setting Static |P Addresses on Cisco Business Hardware for more information.

There may be times where too many DHCP addresses are cached, which can also prevent clients from
getting an |P address. To learn more about this, check out Tipsto Keep the ARP Table Available for DHCP
|P Addressing. Y ou may also reboot the router if thisis more convenient.

Windows Support

If you use Windows, select your wireless connection from the Network Connections panel and verify that its
status is Enabled.

Detailed guidance can be found at the Microsoft Support Forum for troubleshooting wirel ess network
connectivity at the clicking on the following link: Fix Wi-Fi connection issues in Windows.

Maybe the CBW settings need to be adjusted

There are some default settings that might cause connection issues in some older devices. Y ou can try
changing the following settings.

RF Optimization
Step 1

Make sure you are in Expert View for these settings.
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Step 2

Navigate to Advanced > RF Optimization. Toggle on RF Optimization.
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Step 3

Scroll down to the bottom of this screen. Within each radio Data Rates, remove support for lower control
rates to remove older legacy wireless mode clients, such as 802.11b clients.

Lower Density Higher Density
——- _

2.4 GHz Data Rates
1 2556 9 1 12 18 24 » 43 54

Maximum Device Capability

Lower Density Higher Density
—- _

5.0 GHz Data Rates
& 8 12 18 24 % ] 54

No connectivity for some legacy devices

Step 4

A notification will come up that older devices are not supported. The further to the right you dlide, the less
that can connect.

Lower Density Higher Density
2.4 GHz Data Rates _
1 2556 9 11 12 18 24 k] 43 54

802.11b devices not supported

Lower Density Higher Density
5.0 GHz Data Rates _
[ 9 12 18 24 36 45 54

Some legacy devices not supported



Bridge Group Names

If you set up your network with all APs at factory default

When you conducted the Day Zero configurations for your mesh network, a BGN was automatically

created. It isthe same as the first Service Set Identifier (SSID) you entered, up to the first 10 characters. This
BGN is used within APs to associate and make sure the APs are staying connected properly. If you set up
your Primary AP and then join subordinate APs, the BGN should automatically match with no further
configurations needed.

If you reset a Primary AP or moved a configured AP to a new network

If you perform areset to factory default on the Primary AP, or move APs from one configured network to
another, this can cause a mismatch of BGNs.

When an AP triesto join a network in a scenario where the BGN doesn’t match any networks available, the
subordinate AP will still attempt to temporarily join the network with the strongest signal. The AP will be
ableto join the network if it is Allow Listed and approved.

Once the AP has joined the network, since the BGN doesn’t match, the subordinate AP will continue to look
for amatching BGN every 10 to 15 minutes. Thiswill cause the connection to drop and then join again if a
matching BGN isn’t found. This can cause alot of problems with connectivity in the wireless network,
especially when there might be a stronger wireless signal coming from another wireless network.

Asasimple solution, for all APsto work together, you should make sure the BGN on al APs match exactly.
To clear out the BGN on the other APs, you can do afactory reset on them, or you can manually change
each one to match.

If you want to view or change a Bridge Group Name (BGN) on an AP

It is recommended that BGNs get assigned to the mesh extenders with the most hops be configured first,
working up to the least number of hops. After that, the Primary Capable APs BGNs should be assigned. The
Primary AP BGN should be configured last. Y ou can view and change them one at atime by performing the
following steps.

Step 1

Log into the AP and enter your credentials.



asco. CISCo Business

Cisco Business Wireless
Access Point

Welcome! Please click the login button to enter yvour user name and password
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Step 2

Switch to Expert View by clicking on the arrow icon.
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Step 3

Navigate to Wir eless Settings > Access Points. Click on the edit icon of the AP you want to edit or view.
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Step 4

A pop-up will ask for confirmation that you want to edit the AP configuration. Select Yes.

Edit AP

Access Point Radio(s) is in enable state. Editing the AP configuration
will disrupt the network momentarily. Do you want to continue.?

Step 5

Click the Mesh tab. Here you can view and change the Bridge Group Name. If you make changes, be sure
you click Apply.
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Repeat the steps for each AP in the network you want to check. Click the save icon to permanently save any
changes. Keep in mind that when a bridge group name is assigned, the device performs areboot. Since a
reboot interrupts Wi-Fi, it is not recommended during business hours.

A ) = O

Allow Lists

In order to connect other Primary-capable APs and mesh extenders, you need to create an Allow List on a
Primary AP that includes the Media Access Control (MAC) address of all the APs.

In addition, subordinate APs need to be Allow Listed so that the Primary AP can access and upgrade the
other APs, which is essential to keep the network up and running.

This Allow List, along with all APs having the same Bridge Group Name (BGN), helps the APs connect
efficiently and consistently. To add a Media Access Control (MAC) address and label it as Allow List,
complete the following steps.

Step 1

Y ou need to know the MAC address of the AP. If you know the MAC address of your AP, you can skip to
Step 4.

A MAC address includes numbers and lettersin pairs, separated by colons.
Step 2

On most APs, the MAC address can be found on the outside of the actual AP. On the 142ACM and
143ACM you need to slide out the power apparatus to view the MAC address. To do this, apply light
pressure on the AP where the arrows indicate. Slide and lift the power component out.



On the 142ACM and 143ACM, you will seethe MAC address in the locations pointed out below.
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1. Select Wireless Settings
2. Select WLAN Users

4

Step

3. Select Local MAC Addresses
4, Select Add MAC Address



thah : ont Se
e Icl|slclc.' Cisco Business Wireless 140AC Access Point ? R Q |QaporCien search

@ Monitoring

1
'& Wireless Settings
N WLANs WLAN Users

¥ Access Points m 0

% Access Points

Groups
= 2
WLAN Users  Local MAC Addresses @
& Guest WLANSs
¥ Mesh Search 0
ﬁ. Management 0 @ Add MAC Address Refresh ri‘ ri" Number of Blacklist:0 Number of Whitelist:2
[ 4 .
’ SEr\”CeS Action MAC Address Type Profile Name Description
-“’ Advanced Z x 68:ca WhiteList Any WLAN/RLAN CBW142 Mesh Extender
Z x a4:53: WhiteList Any WLAN/RLAN CBW140AC-e488

1 10 + |items per page

Step 5

Enter the following information:

1. MAC Address

2. Description (up to 32 characters)
3. Select the Allow List radio button
4. Click Apply

Add MAC Address

o MAC Address z4-52-0f 1e-16:53

9 Description  ACM141 o

Type () BlackList @ WhiteList e

Profile Name Any WLAN/RLAN

0 e



| nter fer ence and spacing consider ations

Rogues, Interferers, and RF Channels...oh my!

I nterference can cause issues on wireless networks and can come from more sources than ever before.
Microwaves, security cameras, smartwatches, motion detectors, or even fluorescent bulbs can cause
interference.

How much they affect the network can depend on many factors including the amount of power emitted if the
object is constantly on, or if it isintermittent. The stronger the signal or the more frequently it is on the more
problems that can arise.

Rogue APs and rogue clients can cause problems if there are too many on the same channel as well.

Interference can be amajor inhibitor to wireless performance, creating security vulnerabilities and wireless
network instability.

There are tools available to monitor the channel(s) you are currently utilizing. Y ou have the ability to
change channels as well. Check out the following articles for more information.

« |dentifying Rogue Clients
e |dentifying Interferers
¢ Changing RF Channels

Recommendationsfor Spacing and Deployment

1. Place Mesh Extenders in line-of-site of Primary-Capable APs.

2. Downstream Mesh Extendersin line-of-site of parent Mesh Extender.

3. Downstream Mesh Extenders require good/excellent on backhaul SSID signal strength from upstream
Primary-Capable APs.

4. Mesh Extenders should have a minimum Signal to Noise Ratio (SNR) value of 30.

5. Avoid placing Mesh Extenders too close to other Mesh Extenders or other Primary-Capable APs.

The following chart lists the expected coverage areas in an open space. If you deploy your network in an
areathat is not open, reduce these values by 20-30%.
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Recommended Distance Recommended Distance

Model (Meters) (Feet)
CBW240AC 18 - 21 60 - 70
CBW140AC 15-18 50 - 60
CBW145AC 15-18 50 - 60
CBW141ACM 15-18 50 - 60
CBW142ACM 10 - 13 32 - 42
CBW143ACM 10 -13 32 - 42

Signal to Noise Ratio Between “Hops”

In al networks, you need to work on a strong signal between clients and the APs. In a mesh network, you
also need to make sure there is a strong signal between the various APs between each other. If one of the
“hops’ doesn’t have a great signal, a higher signal to noise ratio, you will need to troubleshoot that. Y ou
may need to adjust the location or check to see what is causing interference.

Step 1

Navigate to Monitoring > Network Summary > Access Points and click on any access point in the table to
check the associated client signal strength.
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Step 2

Once the Access Point View opens, look over the information under Performance Summary.
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Access Point View
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default location

Bc:71:0d:55:73:¢c4
a4:b2:39:d7:f1:20
192.168.1.29
c47d4fece3s2, gil
1000 Mbps
CBW145AC-B / 802 11bg:-A 802 11a:-B
PoE/Full Power
FGL2418L84T
802.11n 2.4GHz,802.11ac 5GHz
Spatial Streams : 2 (2. 4GHz), 2 (5.0GHz)
Max. Data Rate : 144 Mbps(2.4GHz), 867
Mbps(5.0GHz)
Start Download

Mot Started

PERFORMANCE SUMMARY

2 4GHz 5GHz
Number of clients
Channels 11 (36, 40, 44, 48)
Configured Rate Min: 1 Mbps, Max: 144 MbpsMin: 6 Mbps, Max: 887 Mbps
Usage Traffic 9.8 MB 3.9GB
Throughput 0 14.5 KB
Transmit Power 20 dBm 18 dBm

Noise Mot Available

Channel Utilization

Interference 59%
Traffic

Admin Status Enabled
Interferer Detection Up

Not Available

12%

12%

Enabled

Up

Y ou can also gather information on al mesh extender Hop counts and Sgnal to Noise Ratio. Navigate to
Monitoring > Network Summary > Mesh Extender.

@ Monitoring @
22 Network Summary

Access Points
Clients

Guest Clients

© Applications

+t Rogues

: : . . = o d >z
e cisco Cisco Business Wireless 145AC Access Point Q A ® B =2 3 &
AP Name AP Model Ethernet M... | Parent AP ... Hop Link SNR (... Channel Ut... = Channel Clients
APB6C71.0D. CBW141AC 6c:71:0d:55 AP6CT71.0D 25 5 (36,40,44,48) 0

Takealook behind the curtain

Syslogs

Being aware of events can help ensure the network runs smoothly and prevent failures. Syslogs are useful
for network troubleshooting, debugging packet flow, and to monitor events.

These logs can be viewed on the Web User Interface (Ul) of the Primary AP and if configured, on remote
log servers. Events are typically erased from the system when rebooted if they are not saved on aremote

Server.

If you would like more information, check out Setting U

Network.

stem M

e Logs

slogs) on a CBW


https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2064-Setting-Up-System-Message-Logs-CBW.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2064-Setting-Up-System-Message-Logs-CBW.html

Support Bundle

A feature that is available on this CBW equipment is to download a support bundle. A support bundleisa
tool that can be helpful in troubleshooting. It provides the AP boot-up logs and specifies the configurations
applied. To get a complete picture, this might need to be done on every AP.

Before downloading the support bundle on the Primary AP, make sure you are running the most current
release of firmware. To update firmware, select the correct link under Applicable Devices | Firmware
Version. If you would like assistance in upgrading firmware, check out Update Software of a Cisco Business
Wireless Access Point.

Step 1

To download the tech support bundle specific to access point functionality, select M onitoring > Access
Points. Select the AP you would like to access.

afealn , , , 2 O -
e e cisco Cisco Business Wireless 145AC Access Point : Q A C) =
@@ Monitoring
28 Network Summary
. Access Points
Clients
2.4GHz i 5GHz
Guest Clients =
Master AP Mesh Extender
Mesh Extender
© Applications
AP Name > Role o Type > Clie... ~ Usage ~ Uptime > Adm... ~ Ope... ¥ Channels o Tran... v
‘4 RDgUES Stat... Stat... Power
s
Access Points
APGCT71.0D55.73C4 Master AP 0 9.2 MB 1days, 02h 17 m Enabled uP 1 20 dBm
Clients
APBC71.0D55.5DA4 Mesh Exten 0 12.4 MB 6 days, 23 h 22 m Enabled up 1 20 dBm

® Wireless Dashboard
AP Performance n
| v v

Step 2

Under the Tech Support section, select Start.


https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html
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Access Point View

GENERAL
(( ))) AP Name
T Location

_ default location
MAC Address Ge: 71
Base Radio MAC ad:b2:39:df:71:20
IP Address 192 .168.1.29
CDP ! LLDP c4d7dd4fece3ds, gil
Ethernet Speed 1000 Mbps
Model / Domain CBW145AC-B J 802 11bg:-A 802.11a:-B
Fower siatus FoE/Full Fower
Serial Number FGLZ418L34T
Max Capabilities 802.11n 2.4GHz,802.11ac 5GHzZ

Spatial Streams : 2 (2. 4GHZ), 2 (5. 0GHZ)
Max. Data Rate : 144 Mbps(2.4GHz), 867
Mbps(5.0GHzZ)

Tech Support Status Mot Started
Step 3

When the download is complete, you will see the Tech Support Satusis Completed. Select the Download
button to download the files. At this point, even if the download happensto fail, it is deleted from the
memory of the AP. Thiswould happen if you don’'t alow pop-ups.



Tech Support Start Download

Tech Support Status Completed

Step 4

In the Download folder of your computer files, you will see atech support .tgz file. Thefilesinside this
folder need to be extracted.

+ | = | Compressed Folder Tools ~ Downloads — O w
Home Share View Extract e

&« “ 4 & » ThisPC » Downloads v Search Do.. @

Mame Date modified Type Size -

# Quick access
@ OneDrive 9 tech_support_APGC71.0D55.73C4 gz 6/29/2020 11:07 AM TGZ File ATKB
Documents

Pictures

W This PC
» 3D Objects
m Desktop
1 Documents

o 4 Downloads

B Music

Step 5

Right-click and select the unzip application that you would like to use. In this example, 7-Zip was used.
Select to extract the files to the location you select. By default, the files are sent to the Downloads folder.



3 | ol = | Compressed Folder Tools Downloads
Home Share Wiew Extract
“~ “ 4 & » ThisPC » Downloads
~
Date modified
s Quick access
@ OneDrive - e 6/20/2020 11:07 AM
Documents Open with
Pictures ﬂ Open with Code
7-Zip >
i This PC CRC SHA 2
5 3D Objects & Edit with Notepad-++
m Desktop = Share
% Documents Fruemrsa >
4 Downloads ﬂ, Cisco AMP For Endpoints h
J' Music Restore previous versions
« Pictures Sand to >
& Videos
Cut
25 Wind :
2% Windows () T
& Network Create shortcut
Delete
Rename
Properties

1,015 iterns 1 item selected 46.8 KB

Type

TGZ File

(Alternative View) If you have a core crash, you might see these folders instead.

ap-core-crash

internal-ap

Mame
&
ctrl
<
-
Step 6

_| tech_support.tar

Liate modded

B/2572020 751 AM

b/ 257040 531 AM
6252020 751 AM
625200 51 AM

Fpe

File folder
File folder
File folder
TAR File

Search Do... @

927 KR

Once the files have been extracted from the .tgz file, they will bein a.tar file. Thisfile will need to be

extracted again.



| s Compressed Folder Tools  tech_support_AP6C71,0055.73C4 - m} X
Home Share View Extract 0

<« v > Search Results in Downloads » tech_support AP6C71.0D55.73C4 v O Searchtec... 0
{o) Name - Date modified Type
# Quick access
| Documents # S tech_support AP6C71.0055.73C4.tor o 6/29/2020 11:07 AM TAR File
4 Downloads
Open
3] Open with Code

Open archive 7-Zip 9 >
Open archive > CRC SHA >
Extract files... &/ Edit with Notepad++
Extract Here |& Share
Extract to "tech_support_AP6C71.0D55.73C4\" 0 Open with...
UEE Give access to >
rEEE e 2 Cisco AMP For Endpoints >

Compress and email...

Add to “tech_support_AP6C71.0D55.73C4.tar.7z"

Restore previous versions

Send to >
Compress to “tech_support_AP6C71.0D55.73C4.tar.7z" and email
Add to "tech_support_AP6C71.0055.73C4.tar.zip" Cut
Compress to "tech_support_ AP6C71.0D55.73C4.tar.zip" and email Copy
Create shortcut
o BE L Delete
Titem 1 item selected 53.5KB = e
]
Properties
Y ou will seethe tech support folder. Double-click on the folder to open the files.
| ¥ = | tech_support_APGCT1.0D55.73C4 - O X
Hame Share View o o
« =3 ~ 4 » Search Results in Downloads » tech_support_APGCT1.0055.73C4 v 0 Search tec... ©
~ Mame Date modified Type

» Quick access
I tech_support_APECT71.0D35.73C4 6/29/2020 2:56 PM File folder '
4 Documents o s— - .
- tech_suppert_APECT1.00553.73C4 tar 6/29/2020 11:07 AM TAR File

4 Downloads #

= Pictures -

Step 8

Within the support bundle, the cli_file (configuration file), msg/sysiogs (event logs), and startlog provide the

most relevant information. The files you see may vary. An exampleis shown here. ::

Step 9

Right-click on the file you would like to unzip. In this example, the file will be unzipped into afolder for
tech_support.



Home Share View Extract o
« v » Search Results in Downloads 5 tech_support_APBCT1.0D55.73C4 » tech_support APECT1.0D55.73C4 w O Search tec... 0@
~ Mame Date modified Type
.. o Quick access
PERCORMANCE, SiNEy b . B APECT1,0D55.73C4_support.10.1.1.0.20200629.110435.wsa_status.json.gz GZ File
| oeumens B APGCT1.0D535.73C4_support.10.1.1.0.20200629.110435.wsa_info.json.gz GZ File
4 Downloads  # () * APSCTI.ODSS.T3CA support 101,10 o GZ File
13 Setw; | M Inbo | B A2 < Pictures o ¥ APGC71.0D35.73C4_support.10.1.1.0. = G7 File
\ " ﬂ Open with Code :
- GZ File
Open archive T e GZ File
Open archive > CRC SHA INFO File
Extract files... & Edit with Notepad++ GZ File
Extract Here | Share GZFile
Bxtract to “APEC71.0D55.73C4 support.10.1.1.0.20200629.110435.tech_supporty” () Open with...
Test archive Give access to >
Add to archive... ﬂ: Cisco AMP For Endpoints >
Compress and email... Restore previous versions
Add to "AP6CT1.0D55.73C4_support.10.1.1. ... 200629.110435.tech_support.gz.7z"
Compress to "APECT1.0D55.73C4_support.10.1.1. ... 200629.110435.tech_support.gz.7z" and email Send to >
Add to "AP6C71.0D55.73C4_support.10.1.1. ... 00629.110435.tech_support.gz.zip" Cut
Compress to "APECT1.0D55.73C4_support.10.1.1. ... 00629.110435.tech_support.gz.zip" and email Copy
Type: + Documents Create shortcut
ype:
g B Sub-task 4 Downloads Delete
b Music Rename
1{;3 Status: o v < z
m v sl 11 s 1 e eolebed 11 & VD Properties [ =
Thetech support folder will appear. Double-click to open the folder.
7 = | tech_support_APBCT1.0D55.73C4 — O X
Home Share View G
e 3 v 4 » Search Results in Downloads » tech_support APGC71.0D55.73C4 » tech_support APSCT1.0D55.73C4 v | O Search tec... Q@
" Mame Date modified Type
o Quick access
D s APBCT1.0D55.73C4_support.10.1.1.0.20200629.110435.tech_support 6/20/2020 3:34 PM File folder
= Documents
B APGCT1.0D55.73C4 support.10.1.1.0.20200629.110435.brain.error.log.gz 6/29,/2020 11:05 AM GZ File
4 Downloads  # B APECT1.0D35.73CA_support.10.1.1.0.20200628.110435.brain log.gz £/29/2020 11:05 AM GZ File
= Pictures ol APECT1.0D55.73C4 _support.10.1.1.0.20200629,110435.info 6/29/2020 11:05 AM INFO File
xml -+ B APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435. messages.gz 6/29/2020 11:05 AM GZ File
B APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435.startlog.gz 6/29/2020 11:05 AM GZ File
B APGCT1.0055.73C4_support.10.1.1.0.20200629.110435.5yslogs.gz 6/29/2020 11:05 AM GZ File
B APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435.tech_support.gz 6/29/2020 11:05 AM GZ File
B APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435.wsa_info.json.gz 6/29/2020 11:05 AM GZ File
B APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435.wsa_status.json.gz 6/29/2020 11:05 AM GZ File

Step 11

Right-click on the file and select atext file reader. In this example, we used Edit with Notepad++.




= | AP6CT1.0D55.73C4_support.10.1.1.0.20200629.110435.tech_support

- O X

“ Home Share Wiew 9
&« v A < tech_support APGCT1.0D055.73C4 » APECT1.0D55.73C4_support.10.1.1.0.20200629.110435.tech_support w B Search AP... 0@
o] MName Date modified Type
s Quick access
AP6CT1.0035.73C4_support.10.1.1.0.20200629.110435 tach connart E{18/0000 1108 AR TECH_SUPPORT File
| Documents o 8
pen with
4 Downloads 3] Open with Code
o Pictures 7-Zip >
sl CRC SHA >
APSCT1.0D55.73 5 Edit with Notepad-++
HTML & Share
Timesheets Give access to b
Troubleshooting ﬂ} Cisco AMP For Endpoints b
. Restore previous versions
@ Onelrive
Documents Send to >
Pictures Cut
C
™ This PC it
» 3D Objects Create shortcut
m Desktop Delete
Rename
4 Documents
4 Downloads Properties
B Music
v < >

Ao

1item 1 item selected 54.8 KB

Accesstothe Primary AP Tech Support Bundle

The Primary AP tech support bundle is the main source of diagnostics. To download the tech support bundle
that is built into the Primary AP or the virtual controller bundle, navigate to Advanced > Primary AP
Tools. Select the Troubleshooting Filestab. Select Download Support Bundle. For Transfer Mode, select
HTTP or FTP. Click Apply settings. Click on the Save icon.

®* Monitoring

£ Wireless Settings
Master AP Tools

*- Management

& Advanced ()
¥ SNMP

B Logging

.l RF Optimization Restart Master AP

e @

Security Setti
BT S » Tech Support

Transfer Mode

Configuration Management

thiah
9 'c||5'c|°- Cisco Business Wireless 145AC Access Point

Troubleshooting Files

HTTP (Local Machine) v

Troubleshooting Tools Upload File

Support Bundle includes configuration, logs and crash files for trouble shooting.
Pop-up blocker should be disabled in Browser settings to upload or download configuration file.




Adjust one of the CBW M obile Phone Settings

Change the 802.11r settings on the CBW Network
Step 1

Access the Web User Interface (Ul) by entering the 1P address of the Primary Access Point into aweb
browser. Make sure you are not on a Virtual Private Network (VPN) or thiswill not work. If you encounter
security warnings, select the prompts to proceed.

C A Notsecure | 192.168.1.124

Step 2

In the upper right-hand of the Web U, click on the opposing arrows to switch to expert view.

A B () = &

[ Switch to Expert View ]

Step 3

A pop-up window will appear, asking if you want to select expert view. Click OK.

192.168.1.124 says

Do you want to select Expert View?

‘ OK Cancel



Step 4

Select WL ANs and the edit icon for the WLAN you want to edit.

e "I:I:s'él‘;' Cisco Business Wireless 145AC Access Point Q A @ = ¥ 'a'

@ Monitoring

£ Wireless Settings ?
N 1 WLANs

% Access Points
;
% Access Points
Groups

% WLAN Users

ﬁ Guest WLANs Add new WLAN/RLAN
l, Mesh Action Active Type Name ssiD Security Policy Radio Policy
! 9@: x Enabled WLAN cisco_1 cisco_1 Personal(WPA2) ALL -
Management @ x Enabled WLAN cisco_2 cisco_2 Guest ALL
'c SerV|CeS @ % Enabled WLAN cisco_4 cisco_4 Personal(WPA2+ ALL
& x Disabled WLAN cisco_3 cisco_3 Open ALL

-+n Advanced

Step 5

A pop-up window will appear, asking if you want to continue. Click Yes.

Edit WLAN

WLAN is in enable state. Editing the WLAN configuration will disrupt the
network momentarily. Do you want to continue.?

Step 6

Click on the Advanced tab. Click on the drop-down menu for 802.11r and select Enabled.



General WLAN Security VLAN & Firewall Traffic Shaping Advanced Scheduling

Allow AAA QOverride

802.11r‘ Enabled 9 v

Over The DS

Step 7

Click Apply.

Cancel

Apply

Step 8

To permanently save these settings, click the save icon on the top right of your screen.

A ©

If all elsefails, reset to factory default settings

An option of last resort, that should only be done to remedy the most severe issues such as losing the ability
to gain access to the management portal, is to perform a hardware reset on the router.

When you reset to factory default settings you lose all configurations. Y ou will need to set up the router
again from scratch so make sure you have the connection details.



The process on the new CBW APsis alittle different than you may have experienced on other APs. For
details on the reset, check out the article Reset a CBW AP back to Factory Default Settings.

Conclusion

It was our intention to give you several different options for troubleshooting your mesh network. Mission
accomplished! Y ou should now have connectivity and can move on with your day.

View avideorelated to thisarticle...

Click hereto view other Tech Talks from Cisco



https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2120-reset-to-factory-default-cbw.html
https://www.youtube.com/playlist?list=PLB4F91009260AB3D7

